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Introduction Welcome

Welcome

SourceXpress is a waveform creation software application. With the various optional waveform modules,
you’re able to create a wide variety of digitally modulated signals and impairment waveforms.

SourceXpress is designed to interface seamlessly with AWG70000A Series arbitrary waveform generators,
either connected to a virtual generator or connected to an instrument.

Connected to a Virtual Generator. The default mode of operation is for SourceXpress to connect to a
Virtual AWG70000A series instrument, configured by you.

When connected to a virtual generator, SourceXpress provides a simulation of the the AWG70000A Series
instrument work space, allowing you access to all controls and settings as if you were working with
an actual instrument.

Because you can create as many virtual generators as you like, each with different configurations, you can
create all your waveforms, sequences, and setups specific to instrument types, all in the absence of an
instrument. Then when an instrument is available, you can simply recall your saved files.

Connected to an instrument. With SourceXpress installed on a networked PC, the software can scan the
network for a AWG70000A Series instrument and connect directly to the instrument. The interface of the
AWG70000A instrument is displayed in the SourceXpress application window, providing you access to
all instrument controls, directly from SourceXpress. (The instrument itself displays a message that it is
being externally controlled.)

You can remotely connect to multiple AWG70000A series instruments, and control them, one at a time,
via SourceXpress.

In addition, you can control an active generator via the instruments GPIB programming commands. You
must send the GPIB commands to SourceXpress and then SourceXpress passes the command to the active
generator. Refer to the instrument’s programming manual for instrument specific commands.

NOTE. Menus and controls of the selected active generator are not described in this help system. Refer
to the documentation for instrument type chosen.
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Introduction Documentation
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Variable workspace interface

This shaded area of the display is dependant on the type of
instrument selected as the active generator.

For operation of the active generator, refer to the
documentation for the instrument type.

Workspace interface

The workspace provided in SourceXpress is dependent on the chosen active generator, regardless of
whether it is a virtual generator or connected to an instrument.

For operating information about the controls of the displayed generator, refer to the documentation
available for the specific instrument.

All documentation is available on the Tektronix web site (www.tek.com/manual/downloads ).

Documentation

In addition to this application Help system, the following documentation is available for the software.
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Introduction Support information

All documentation is available on the Tektronix web site (www.tek.com/manual/downloads ).

To read about Use these documents

SourceXpress operation and user interface help  Access the SourceXpress application help from the Help menu for
information on all controls and elements on screen.
The SourceXpress help system is also available in PDF format, available
on the Tektronix web site.

SourceXpress programmer commands Access the SourceXpress programmer manual for the syntax of remote
commands.

This document is available in PDF format located in the program’s
installation folder and also available on the Tektronix web site.

Connected instrument operation and user For operation and interface help of a connected instrument, refer to the
interface help instrument’s documentation.

This is available with the instrument or on the Tektronix web site

Connected instrument programmer commands For programming information of a connected instrument, refer to the
instrument's documentation.

This is available with the instrument or on the Tektronix web site.

Support information

Tektronix offers the following services in support of their products:

m  Technical Support. For application-related questions about a Tektronix product, contact us by
telephone or email ).

m  Service Support. For service-related questions about a Tektronix product, contact us by telephone

or email ).

Tektronix also offers extended warranty and calibration programs as options on many products. Contact
your local Tektronix distributor or sales office.
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Orientation Elements of the display

Elements of the display

The main areas of the application window are shown in the following figure.

NOTE. The workspace area is not discussed in this document since its content is based on the type of
instrument selected as the active generator. For information about controls of the active generator, view
the instrument s documentation available from the Tektronix web site (www.tek.com/manual/downloads ).

SourceXpress
Restore tools help |
B SourceXpress® [E=SE=R=
Menu bar ( File gannpedwity Tools Windows Help
Open anld
save tools ome
[For(eTngA] IFm(ETrigB] [Aummml)ﬂ] - nctions
Available - K - T - Amplity Vep
instruments
@VirtualGen AWGT0001A
@AWGT0002
Waveforms
and
sequences
Run | Continuous - Coupled SR: 25. S/s

Variable workspace interface

This shaded area of the display is dependant on the type of
instrument selected as the active generator.

For operation of the active generator, refer to the
documentation for the instrument type.

Play button

The play button starts and stops the waveform playout when SourceXpress is connected to an instrument
and the connected instrument is set to Active in the Connected Generators tab.
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Orientation Menu bar

If a virtual generator is active (selected in the Connectivity tab), the Play button is not enabled.

Menu bar

The Menu bar provides access to various actions.

File (see page 6) provides access to various open, save, and setup actions.

Connectivity (see page 8) provides access to add generators to the Connected Generators tab.

Tools (see page 8) allows you to hide pop-up error messages, forcing the errors to only show in the
Status bar at the bottom of the screen.

Windows (see page 9) allows you to collapse or expand the tabbed panels.

Help (see page 9) provides access to the SourceXpress User manual and information about SourceXpress.

File menu

6 SourceXpress Printable Help Document



Orientation File menu
Item Description
Reset Default Setup Returns all settings of the active generator to the factory settings.

NOTE. The contents of the active generator’s Waveforms tab, Sequences tab,
and Captured Signal List are removed.

The contents of these lists of any connected instrument are not affected.

Recall Last Setup

Returns the active generator to the setup that was last accessed.

Open Setup... Opens a window to allow you to navigate to saved setup files. Opening a setup file
returns the active generator to the settings saved with the setup file. Waveforms
and/or sequences saved with the setup file are also restored, removing all existing
waveform and sequence files.

Save Setup... Saves the current settings as a setup file, allowing you to easily return the application

to a known setup. A windows Save As dialog box opens to the most recent location
accessed. Use this window to navigate to where you want to save the setup.

In the Save As window, you can choose to save the setup file (which includes all
waveforms and sequences) or save the setup file without the assets (which excludes
all waveforms and sequences).

File name: -

Save as type: |AWGT0000 Setup (*.awgx) -
AWGT0000 Setup (".awgx) |

AWGT0000 Setup without assets (*.awgx)

The factory location is C:\Program Files\Tektronix\SourceXpress\Samples.

NOTE. Signals listed in the Capture/Playback tab are not saved as part of the
setup file.

Open Waveform...

Opens a window to allow you to navigate to saved waveform files. Performs the
same actions as the Open Waveform button in the Waveforms tab, opening any of
the supported file types. Refer to Open File for a description of the actions taken
depending on the type of file being opened.

Open Sequence...

Opens a window to allow you to navigate to saved sequence files. To add a sequence
to the Sequences tab, select the Open Sequence button. This opens a Windows
dialog box that allows you to navigate to a saved sequence or setup file. If the
sequence or setup file is a valid file type, the sequences are added to the Sequences
tab and waveforms (used in the sequence) are added to the Waveforms tab.

Exit

Exits the application.

SourceXpress Printable Help Document



Orientation Connectivity menu

Connectivity menu

Connectivity

Connect to Virtual Generator...

Connect to Virtual Generator... Displays the Available Virtual Generators dialog screen.

Enables you create virtual generators and add selected virtual generators to the
Generators List.

Refer to Connectivity (see page 15) for information.

Tools menu

Toaols

Disable error pop-ups

Licenses...

Item Description

Disable error pop-ups Enables or disables the pop-up error message windows. When disabled, error
messages only show in the status bar at the bottom of the screen.

The status bar shows the following icon to indicate that pop-up error messages
are hidden.

‘e

Licenses... Displays the License Management window. The License Management window
displays the installed plug-in licenses and access to install or return a license.

See Licensing (see page 59) for information about how licensing works.
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Orientation Windows menu

Windows menu

Windows

v Connected Generator List
v Waveform List
v Sequence List

Reset Window Layout
Item Description
Connected Generator List Displays or hides the Connectivity tab.
Waveform List Displays or hides the Waveforms tab.
Sequence List Displays or hides the Sequences tab.
Reset Window Layout Returns all application windows to their original location and display. For example, all

undocked tabs are returned to their original location and all closed tabs are reopened.

This is performs the same function as the icon in the Restore tools.

Help menu

Help & Support button: Help & Support provides links where you can obtain additional product help and
documentation. About my SourceXpress button: About my SourceXpress provides you with detailed
information about your instrument, such as installed options and software version. This information is
helpful when contacting Tektronix about your instrument. You can use the Copy Instrument Info button to
copy and paste the instrument information into another application such as an email program.

Item Description
User manual
Opens the application help system, same as the icon.
About SourceXpress... Provides you with detailed information about your application, such as the software

version. This information is helpful when contacting Tektronix about your instrument.

Use the Copy System Information button to copy and paste the instrument
information into another application such as an email program.
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Orientation

Open and save tools

Open and save tools

10

The Open and Save tools provide access to various open, save, and setup actions.

Open File allows you to open any of the supported file types. The action taken depends on
the file type opened.

B Setup files: Opening a saved setup file returns the instrument to the settings saved with the
setup file. Waveforms and/or sequences saved with the setup file are also restored, removing
all existing waveforms and sequences.

m  Waveform files: Opening a waveform file from the toolbar allows you to select one waveform
file at a time to load into the Waveforms tab. (Matlab files that contain more than one waveform
will have all waveforms loaded into the Waveforms tab.

See Adding a waveform (see page 23) for more information.

B Sequence files: Opening a sequence file from the toolbar allows you to select one sequence
file at a time to load into the Sequence tab. If the sequence file contains subsequences, these
are also placed in the Sequences tab. All waveforms used in the sequence are loaded into
the Waveforms tab.

See Adding a sequence (see page 46) for more information.

A windows Open dialog box opens to most recent location accessed. Use this window to navigate
to your files.

The factory location is C:\Program Files\Tektronix\SourseXpress\Samples.

For more advanced options to add waveforms or sequences, use the Open icons located within
the Waveforms tab and Sequences tab panels.

Save Setup saves the current settings as a setup file, allowing you to easily return the active
generator to a known setup. A windows Save As dialog box opens to the most recent location
accessed. Use this window to navigate to where you want to save the setup.

In the Save As window, you can choose to save the setup file (which includes all waveforms
and sequences) or save the setup file without the assets (which excludes all waveforms and
sequences).

File name: -

Save as type: | AWG70000 Setup (*.awgx) -
AWGT0000 Setup (*.awgx)

AWGT0000 Setup without assets (*.awgx) |

The factory location is C:\Program Files\Tektronix\SourceXpress\Samples.

NOTE. Signals listed in the Capture/Playback tab are not saved as part of the setup file.
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Orientation Restore tools

Restore tools

The Restore tools provide access to various actions to return the application to known setups and graphical

layout.
L&) &)

Reset to Default Setup returns all settings of the active generator to the factory settings.

@

@

NOTE. The contents of the Waveforms tab, Sequences tab, and Captured Signal List are
removed.

The contents of these lists of any connected instrument are not affected.
Restore Last Setup returns the application to the setup that was last accessed.

Reset Window Layout returns all window panels (moved or undocked) to their original locations.

The User Manual button displays the help system.

S@fE)

Screen interface features

The graphical user interface (GUI) is designed with some features that are only accessible via the right
and left mouse clicks.

SourceXpress Printable Help Document 1



Orientation

Screen interface features

Left mouse click

Left mouse click on any control or setting to select or activate that control.

Right mouse click

Right mouse click on various areas, controls, and settings display a menu of available actions.

In some instances, a right mouse click is the only method to access some menus. For instance,
right click on one of the generators in the Connected Generators list to display the menu to activate,
disconnect, or display instrument properties.

Connected Generators

Mame

VirtualGen_AWG70002

Set to Active

Disconnect

Properties

Pull down lists Selections with a triangle incorporate a pull-down list. Left mouse click on the triangle to display
the list
| Q - |
zenerator List
Drag and drop Use the left mouse click to drag a waveform from the Waveforms tab onto the waveform display

area. If a waveform is already attached to the channel, the waveform is replaced. If the previous
waveform was currently playing, the new waveform starts playing immediately.

12
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Orientation Screen interface features

Window resizing The various window panels can be adjusted in size where-ever two panels are divided. Use the
right mouse click to grab the 3 dot indicator and slide to increase or decrease its size.

fun | Continuous v
Wavefnrm;

El Open Waveform

Name \ Length |

Waveform 1 10

R) Channel 2 ‘Waveform_1
Ind|cates where panels

T ““““““ll

Undocking and Any tab can be undocked from the GUI. This allows you to reposition a tab to a new location
docking tabs or completely separate it from the main GUI. Use a left mouse click to grab a tab and slide it

to a new area. The docking icon displays that you can use to choose how you want to dock
reposition) the tab.

Use the Reset Window Layout button to return the display to the factory settings.
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Connectivity Connectivity

Connectivity

The Connectivity tab contains the list of generators that are currently connected to (or available for
connection) SourceXpress, whether it’s a virtual generator or an instrument. You can connect as many
generators as you wish, but only one can be active at a time.

At initial startup of SourceXpress, a Virtual generator is connected by default, named
VirtualGen AWG70002. This is automatically set to be the active generator and displays a simulated
AWG70002A interface. You can create additional virtual generators and choose

Virtual Generator. The default mode of operation is for SourceXpress to connect to the default virtual
generator, simulating an AWG70000A series instrument. You can create other virtual generators, each
with different configurations. Once you create additional virtual generators, you can choose a different
default virtual generator. (Right mouse click in the Available Virtual Generators screen to select the
default generator.)

When connected to a virtual generator, you can create all your waveforms, sequences, and setups specific
to instrument types, all in the absence of an instrument. Then when an instrument is available, you can
simple recall your saved files.

Connected to an instrument. With SourceXpress installed on a networked PC, SourceXpress can remotely
connect and control any AWG70000A instrument on the network. The interface of the connected
AWG70000A instrument is displayed in the SourceXpress application window, providing you access to all
its instrument controls, directly from SourceXpress.

Generator List

The Connectivity tab contains your list of available generators connected (or available for connection) to
SourceXpress. You can connect to as many generators as you wish (virtual generators and instruments),
but you can only have one active at a time.

NOTE. When SourceXpress is connected to an instrument, the instrument s display will indicate that it is
being externally controlled. Control of the instrument can easily be regained directly from the instrument’s
display, or by disconnecting the instrument from SourceXpress via the Generator List.
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Connectivity Generator List

16

Instrument search —¢| Q ~|
Generator List
Name | Type | Auto Connect |
Active generator ) i Connected
. ®VirtualGen AWGT70002A  Virtual AWGT0000 virtual
is in bold type
_ _ generators
®VirtualGen_AWG70001A Virtual AWG70000
Connection status
Green - Connected @ CAWGT0001 AWG70000 a
Grey - Mot Connected _Connected
Yellow - Lost Connection ®AWG70002 AWG70000 2 instruments

Red - Active Generator @
Lost Connection

When SourceXpress is started for the first time, one Virtual generated is created and appears in the
Generator List as the active generator along with the simulated display of the generator.

As you modify the Generator List (add/remove generators (virtual or real instruments), SourceXpress
retains the latest list of generators and repopulates the list when SourceXpress is restarted.

When SourceXpress is restarted, SourceXpress populates the Generator List as follows:
= All previously existing virtual generators appear in the Generator List and are connected

m  All previously existing instruments appear in the Generator List but are not connected unless Auto
Connect is checked for that instrument. If Auto Connect is checked, SourceXpress attempts to
re-establish a connection.

m [fa virtual generator was the active generator at shut down, the same virtual generator is active.

B [fan instrument was the active generator at shut down, the same instrument will be active only if Auto
Connect was checked and SourceXpress was able to reestablish a connection. Otherwise, the active
generator will be the virtual generator defined as the default generator.

Virtual Generators

You can create as many virtual generators you like, each with different configurations. Use the
Connectivity > Connect to Virtual Generator... menu to display the list of virtual generators or to continue
on to create a new generator. When connected to a virtual generator, you can create all your waveforms or
sequences, create setups specific to an instrument type, all in the absence of a real instrument. Then when
an instrument is available, you can simple recall your saved files.

Connect to instruments

With SourceXpress installed on a networked PC, SourceXpress can remotely connect to and control
any AWG70000A series instrument on the network. The interface of the instrument is displayed in

the SourceXpress application window, providing you access to all instrument controls, directly from
SourceXpress.
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Connectivity Generator List

Instrument search/connect

The connectivity tab provides a window for you to enter the computer name (hostname) or IP address of
a networked instrument you wish to connect to.

After entering the hostname or IP address, select the magnifying glass (or press Return) to initiate
searching for the instrument. When the connection is established, the instrument is added to the Generator
List. The name appearing in the Generator List is the same as entered in the Connectivity window. You
can rename a generator by selecting it and use the right-click rename menu.

To obtain the hostname or IP address of an instrument, go to the target instrument, select Computer >
Properties and note the computer name or IP address.

Selecting the active generator

From the Connectivity tab, you select which instrument you want to access, regardless if it’s a virtual
generator or a connected instrument. Making the generator active brings its display into view.

There are two methods to make a generator active:
B Double click on the generator.
B Right-mouse click on the generator and select Set to Active from the pop-up window.

Next to the name of each generator, the Type of generator is displayed to help identify instruments from
virtual generators.

Connection status indicators

Next to each generator name in the Generator List is a colored icon to indicate the connection status
of that generator.

B Green indicates SourceXpress is connected to the generator. Virtual generators are always connected.
m  Grey indicates SourceXpress is not connected to the generator.
B Yellow indicates SourceXpress lost connection to the generator but it was not the active generator.

B Red indicates SourceXpress lost connection to the generator and it was the active generator.

Auto Connect

Use the Auto Connect feature to automatically establish a connection to the selected instrument when
SourceXpress is launched. You can choose to automatically reconnect to any or all instruments (currently
in the Generator List) when SourceXpress is launched.

Auto Connect is not available for virtual generators since they are connected at all times.

Right-click menu operations

Right mouse click on any generator name displays a menu of actions.
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Connectivity Connect to a virtual generator

Set to Active

Connect

Properties

Wirtual generator
=gl Properties

Connected instrument

menLl

Item Description

Set to Active Sets the selected generator to the active generator, bringing its controls into view.
Only one active generator is allowed at a time.

Connect Establishes a connection to the selected generator.
This is not available if a virtual generator is selected. Virtual generators are always
connected.

Disconnect Disconnects the selected generator from SourceXpress. The generator name

remains in the Generator List and can be reconnected with the Connect menu.

Remove Disconnects the selected generator from SourceXpress and removes it from the
Generator List.

NOTE. You cannot remove the default virtual generator.

Rename Displays the Rename dialog screen for the selected generator. If a generator has
been renamed, you can locate its original name by displaying the Properties of
the generator.

Properties Displays the system information about the selected generator.

Connect to a virtual generator

To connect to a virtual generator, you must select the menu Connectivity > Connect to Virtual Generator...

This displays the Available Virtual Generators window.
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Connectivity Connect to a virtual generator

m Available Virtual Generators EI@
Select virtual generators to connect
Mame | Madel | Options |
VirtualGen_AWG70001_1  AWGT70001 01,150, 03
VirtualGen_AWG70001 AWGT0001 01,150, 03, AC

*The default Active generator

From this list, you can select one (or more) virtual generators to add to the Generator List (see page 15).

The default virtual generator is indicated with an asterisk (*). The default generator is the virtual generator
that is initially connected to upon application start-up.

NOTE. The initial list of virtual generators only contains the default virtual generator. You can add
additional generators using the Create Generator button. See Creating virtual generators (see page 20).

Not all controls are enabled
When a virtual generator is the active generator, controls that depend on instrument hardware are not active.

For example, controls such as the Play/Stop button, Force Trigger buttons, Channel on/off buttons, (and
others) are not available.

Right-click menu operations

Right mouse click on any generator name displays a menu of actions.

Set as Default Virtual Generator
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Connectivity Connect to a virtual generator

Item Description

Set as Default Virtual Generator Defines the generator that is automatically connected to when the application is
started.

Remove Removes the generator name from the list.
You cannot remove the default generator but you can reassign which is the default
generator.

Creating virtual generators

You can create additional virtual generators, each with its own set of properties, such as a two-channel or
single-channel instrument to simulate actual instrument you may connect to in the future.

From the Available Virtual Generators window, select Create Generator.

[E¥ Create Virtual Generator EI@

Name | VirtualGen_AWGT70001_2

Models Options
AWG70001 Sample Rate
AWGT0002

@® 150 - 50 Gsample/s

B 01 - Memory Expansion (2 to 16 Gpaint)
B2 03 - Sequencing

B2 AC - AC Amplifier and Attenuator

Item Description

Name Use to define a name for the generator you are creating.

By default, the name is given a base name of VirtualGen with the model type
appended to the name. If needed, the name is appended further with a numerical
value.

You can overwrite the Name field entirely by typing in a generator name.

NOTE. You cannot duplicate or overwrite an existing Virtual Generator name.

Models Choose the model you want to simulate

Options The options selections change depending on the model selected. This allows you to
only choose options appropriate for the selected model.
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Connectivity Connect to an instrument

Item Description

Create Creates the generator as defined, and adds the named generator to the Available
Virtual Generators window.

NOTE. This only creates the generator and it becomes available as another
generator to connect to.

You still must select any new generators in the Available Virtual Generators window
to connect to them (thus adding them to the Generator List).

Cancel Exits out of the Create Virtual Generator window without creating any new generators.

Connect to an instrument

To connect to an instrument, use the instrument search field in the Connectivity tab.

Connectivity

| Q -

NOTE. If the Connectivity tab is not displayed, enable the setting “Connected Generator List” located in
the Windows menu. or press the Reset Windows Layout button.

Enter the computer name (Hostname) or the IP address of a networked instrument you wish to connect to.
Select the magnifying glass to initiate searching for the named instrument.

If the instrument is found, it is added to the Generator List and connected to SourceXpress.

NOTE. TCP/IP port 59557 is required to be open for the WCF (Windows Communication Foundation)
connection. For example, when communicating through a router.

Once an instrument is connected to SourceXpress, its display is disabled. A message is displayed
indicating it is being remotely controlled. The connection can be disabled directly from the instrument’s
screen by ending the remote session.
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Waveforms tab Waveforms tab

Waveforms tab

The Waveforms tab contains the waveforms available to assign to a channel. Right-mouse click on a
waveform to display a pop-up menu of tools to modify waveforms, assign a waveform to a channel, save,
remove waveforms, and view a waveform’s properties.

Name | Length |
: Wave 1 2.4k
: Wave 2 24k Right mouse click.<
I
5 Wave_4 24k
: Wave S 24k
Properties

You can drag and drop a waveform from the Waveforms tab onto the channel’s graph area, assigning
that waveform to play on the channel.

Adding a waveform

To add a waveform to the Waveforms tab, select the Open Waveform button. This opens a Windows
dialog box that allows you to navigate to a stored waveform, setup file, or sequence file. (You can load
waveforms contained in Setup files and sequence files.)

If the waveform is a valid waveform type, the waveform is added to the Waveforms tab. Once a waveform
is in the Waveforms tab, it can be assigned to a channel for playout. Click here to see the list of valid
waveform file types.

Valid file types Description

AWGKX file format Setup file created by Tektronix AWG70000A Series instruments or SourceXpress.
Setup files can contain multiple waveforms and multiple sequences.

NOTE. Opening a setup file from the Waveform List does not restore the instrument
settings, only the waveforms contained in the setup file are restored.

WFMX file format Created by Tektronix AWG70000A Series instruments or SourceXpress.

SourceXpress Printable Help Document 23



Waveforms tab

Adding a waveform

Valid file types

Description

AWG file format

Setup file created by Tektronix AWG5000 or AWG7000 Series instruments.

NOTE. The Tektronix AWG5000 or AWG7000 Series instruments had predefined
waveforms available for use.

Saved setup files that used predefined waveforms did not save the actual waveform
data with the setup, only the waveform name. Hence, importing setup files that
used predefined waveforms will not import the waveforms. To import these types of
waveforms, first copy and rename the predefined waveform, then save the setup file
before importing to the AWG70000A Series instruments.

\WFM file format

Created by Tektronix AWG5000/7000 Series instruments.
Created by Tektronix AWG400/500/600/700 Series instruments.
Created by Tektronix TDS/DPO/MSO/DSA Series instruments.

.ISF file formats

Created by Tektronix TDS/DPO/MSO/DSA Series instruments.

.PAT file formats

Created by Tektronix AWG400/500/600/700 Series instruments.

QT file format

Created by Tektronix RSA3000 Series instruments.

.TIQ file format

Created by Tektronix RSA6000/5000 Series, SPECMON Series ,MDO4000 Series
instruments. or SignalVu-PC.

.TFW file format

Created by Tektronix AFG3000 Series instruments.

TXT file format

Created by Tektronix AWG5000 or AWG7000 Series instruments.

.RFD file format

Created by Tektronix RFX100 RFXpress Advanced RF/IF/IQ waveform software.

.SXD file format

Created by Tektronix SDX100 SerialXpress high-speed serial data signals software.

.MAT file format

Matlab file type (Level 5 or Level 7.3) for AWG70000A Series.
Matlab file type for RSA6000/5000 Series and SPECMON Series.

.TMP file format

Midas BLUE file type.

.PRM file format

Midas BLUE file type.

With the Sequencing option (Option 03), the following files types are also valid waveform sources.

.SEQX file format

Sequence file created by Tektronix AWG70000A Series instruments or SourceXpress.

.SEQ file format

Sequence file created by Tektronix AWG400, AWG500, or AWG600 Series
instruments.

If selecting a file type containing multiple waveforms ((AWGX, .MAT, .AWG, .SEQX), you are presented
with the Available Waveforms dialog box (see page 25) that lists all waveforms contained in the setup file.

You can load all the waveforms or select a subset of the waveforms.

NOTE. When opening an AWG70000A Series setup file (AWGX) from the Waveforms tab, only the
waveforms are extracted,; instrument settings contained in the setup file are not restored. Use the File
> Open Setup... menu in the Menu bar (see page 10) to restore both the settings and waveforms from a

AWGKX setup file.

If you want any of the waveforms (extracted from a setup file) to be available outside of the setup file,
select and save each individual waveform.
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Waveforms tab

Adding a waveform

Available waveforms

% Available Waveforms
Select waveform(s) to open

[F=| BN [Ec)

Name ‘ Length‘ Date

Select all Unselect all ]

‘ Sampling Rate‘

Sine50_8Bits 50 4/18/2013 8:37:41 AM ---S/s

Sine50 48 8Bits 24k 4/18/2013 8:38:17 AM ---S/s

o | [ s

When adding an analog waveform file that exceeds the amplitude range of the instrument, you are
presented with the Importing waveform dialog screen (see page 25) to normalize (rescale) the waveform

while adding to the Waveforms tab.

Import waveform

I Importing Waveform

(+/-0.25V full scale)

Rescale

{Scale to Max Amplitude

Max & Preserve Offset

—

Don't Rescale J
Cancel J

—

The selected waveforms may not match this instrument's amplitude range.

]

When adding a digital text (. TXT) waveform file, the Import Digital Waveform Text File (see page 26)
dialog box displays to specify the digital bit resolution of the file before the waveform is added to the

Waveforms tab.

Choose from the following:
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26

m 8 Bits (waveform + 2 markers): For 10 bit files that use 8 bits for data, and two bits for markers.
® 9 Bits (waveform + 1 marker): For 10 bit files that use 9 bits for data, and one bit for a marker.
10 bits: For 10 bit files without markers.

It’s important to know the details of your waveform before you import so you do not affect the integrity of
the waveform. For instance, selecting 10 bits for a waveform that is intended to use 8 bits for data and two
bits for markers will add the marker bits to the waveform data and markers will not be available.

Import digital waveform text file

e Import Digital Waveform Text File @

Resolution

[ 8 Bits (waveform + 2 markers) ]

[ 9 Bits (waveform + 1 marker) ]

[ 10 Bits (10-bit waveform, no markers) ]

NOTE. If sequencing is available, waveforms are also added to the waveforms tab when loading a
sequence file or setup file that contains a sequence.

Multi-waveform select

Through the Open Waveform menu in the Waveforms tab, you can select multiple waveform files to load
into the waveform list at once.

To select a contiguous block of files, click the first file in the block. Then hold down the Shift key as you
click the last file in the block. This will select not only those two files, but everything in between.

To select multiple files that are not a contiguous block, click one file. Then hold down the Ctrl key while
you click each additional desired file.

If your selection includes sequence files or setup files, all waveforms saved with those file types are
loaded into the waveform list.

CAUTION. Loading groups of waveforms will overwrite any existing waveform of the same name in
the Waveforms tab without warning.

SourceXpress Printable Help Document



Waveforms tab Adding a waveform

NOTE. Multiple file selection is available via the Open Waveform menu. Loading waveforms from the
Open File menu (in the tool bar) or from the pull-down list in the graphical waveform area does not
support multiple file selection.

SourceXpress Printable Help Document 27



Waveforms tab Saving a waveform

Saving a waveform

To save a waveform, right mouse click on a waveform and select Save or Save As. This opens a Windows
dialog box that allows you to navigate to a location to save the waveform.

Apply corrections
Right click on any waveform (or two waveforms for I/Q correction) and select the Apply Corrections menu.

Modify Waveform

Apply Corrections

With the Apply Corrections dialog screen, you can choose to apply one of two types of correction:
m  Sin(x)/x distortion correction

B Apply a correction file (coefficient file)

% Apply Correction @

. Sin(x)/x distortion correction

End Frequency 6 GHz ]

r

. Correction File Path ] |‘ ‘%‘

L

! Qverwrite Waveform] [ Apply ] [ Cancel ]

For information about the two types of correction, refer to these sections:

m  Apply Sin(x)/x correction (see page 37)

B Apply correction file (see page 37)
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Waveforms tab

Assign a waveform to a channel

Assign a waveform to a channel

To play a waveform, you need to assign it to a channel. This is true even for a single channel instrument.

There are several methods to assign a waveform to a channel.

®  Drag a waveform from the Waveforms tab onto a channel’s plot area.

B Right mouse click on a waveform name in the Waveforms tab and use the pop-up window to assign

it to a channel.

[ Open Waveform

Force Trig A [

Name

‘ Len: to assign waveform/sequence

Modify Waveform 4
Modify Markers

Make a

Apply Correction

Save

Save As...

Rename

Assign to Channel 1

Tp Channel 2 &
W& IVE

Remove All

Properties

m  Use the drop-down list in the channel’s plot area to assign the channel to play a waveform.

You can choose waveforms already loaded into the Waveforms tab or you can browse for waveform
files. Selecting a waveform by browsing, the waveform is added to the Waveforms tab and assigned
to the channel for playout.

If Sequencing is available, you can also open a sequence type file and load any of the waveforms
that were saved with the sequence.
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Waveforms tab

Modify waveform

(D Channel 1| Wave 1

25 mV Wave 1
Waveform List...
Browse for Waveform...
]
g Sequence List...

0 12k

Browse for Sequence...

Run  Triggered Modify Waveform...

Coupled

Modify Markers...

(D Channel 2 Clear

Modify waveform

30

You can select any waveform contained in the Waveform List to modify it or create a new waveform based
on the existing waveform. But note the following conditions:

B Any waveform can be modified by selecting Modify Waveform > {Resample / Scale/Offset /
Rotate/Shift / Pattern}. Select one of these waveform modifiers displays the Modify Waveform (see

page 31) dialog screen.

B [fselecting a waveform that was created with a Waveform Plug-in, a menu choice is added to take you
directly to the specific Waveform Plug-in editor screen.

B With an S-Parameter license, you also have the option to apply S-Parameters to the waveform. Refer
to the section about Appling S-Parameters (see page 39).

Select a waveform in the Waveform List and right mouse click to display the waveform operations.
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Waveforms tab Modify waveform

l E Open Waveform l

Mame | Length |

Pattern

Open in Bas form Plug-in

A waveform created with a waveform plug-in
has a menu selection to open the waveform
with the proper waveform plug-in

Apply S-Parameter menu selection requires |
an S-Farameters license

Select one of the waveform modifiers to display the Modify waveform dialog screen (see page 31).

Modify waveform dialog screen

The Modify waveform dialog screen provides you with the controls and settings to modify a waveform
and save it as a new waveform or overwrite the original waveform.

T Modify Waveform ===

Waveform 3

Sample Rate / Length

T Current Requested
Resam ple Waveform | }
. Multlply By Sample Rate 2o | 12 G5/s
Add or Subtract e By ot . —
Samples |
Repeat [ Length | }
@ Waveform : (Samples) 24k & 2.4 kSamples
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Waveforms tab

Modify waveform

Here are tips and notes about using the Modify Waveform feature:

B The waveform must be in the Waveform List.

= New or modified waveforms are placed in the Waveform List, but are not automatically saved to the
hard drive (or other location). They do become part of the setup file if the setup is saved. To make a
modified waveform available for use in other setups, select the modified waveform and use Save or
Save As to save the waveform.

B Only one modification is allowed at a time, requiring you to compile the new waveform for each
modification. This avoids any uncertainty of modifications since some modifications can affect other

characteristics.

B Some modifications may cause a reduction in fidelity to the new waveform.

B The waveform displayed in the dialog screen represents the modified waveform before compiling.

Sample Rate / Length tab

Resample, Multiply

Increases the number of samples of the waveform.

By

Add or Subtract Adds samples to the end of the waveform by repeating the last sample of the waveform.
Samples

Repeat Waveform Duplicates the waveform the defined number of times.

Scale / Offset tab

Multiply by The scale and offset tab allows you to modify the output amplitude and offsets using the Multiply

by value. Fractional values are allowed.
You can use the Show more options check box to display and adjust individual settings.
Only the analog data is modified. Markers are not affected.

Normalization
Presets

The Scale to Max Amplitude adjusts all values to obtain the full scale amplitude of 500 mVpp.

The Max & preserve Offset adjusts the values to their maximum value while preserving the offset
value.

Rotate / Shift tab

Rotate waveform,
wrap samples

Enter a value in degrees or number of samples to rotate the waveform horizontally. Rotating the
waveform takes the end of the waveform (defined by the degrees or samples) and moves it to
the front of the waveform.

Shift waveform,
repeat sample to
fill

Enter a value in degrees or number of samples to shift (or move) the waveform horizontally.
Shifting moves the waveform and repeats the first waveform sample value to fill in the waveform.
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Waveforms tab Modify markers

Rotate / Shift tab
Apply Rotation/Shift Rotation and Shift is available for the analog data and the markers.
To
Shifted >>
Rotated >>
Pattern tab

See the Modify markers (see page 33) section on using the Pattern features.

Modify markers

You can select any waveform contained in the Waveform List to modify the waveform markers.

Select a waveform and right mouse click to display the waveform operations.

‘ [ Open Waveform |

L 0_8Bits

Modify Waveform

Sy Modify Markers

: Wavefor Make a Copy

Select Modify Markers to display the Pattern editor tab in the Modify Waveform dialog screen.
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Waveforms tab

Modify markers

T Modify Waveform
Sine50_48_10Bits

=)o

Pattern Type Apply Modification To
High v D Analog
. Marker 1
. Marker 2

Range

M2:
920 960 1k 1120k

B2 g

Overwrite Waveform E

.J

Compile Close

The pattern editor allows you to modify the Analog waveform and/or the Markers. Once you’ve defined
your changes, you need to compile the new waveform. By default, a new waveform is created (based on

the existing name) and is placed in the Waveform List.

The controls are described below.

Pattern Type. Three patterns are available:

= High: The sample points (all samples or between cursors) are set to their high values. Marker samples
are set to 1. The analog waveform samples are set to the waveform maximum value.

B Low: The sample points (all samples or between cursors) are set to their low values. Marker samples
are set to 0. The analog waveform samples are set to the waveform minimum value.

B Pulse: The sample points (all samples or between cursors) alternate between their high and low values

for the defined number of samples.

When choosing Pulse, additional settings are displayed:

Pattern Type

{Puhe

Start Level [ High

High Steps | 200 Samples

Low Steps | 100 Samples

Number of cycles: 8

34
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Waveforms tab Properties

Start Level defines whether the cycle of pulses start from their high or low value.
High Steps defines how many sample points are set to high.
Low Steps defines how many sample points are set to low.

The combined number of samples for the High and Low steps are limited to the number of samples
available in the waveform

The number of pulse cycles is calculated and displayed. The number of cycles based on the number of
samples used for the high and low steps and if it’s being applied to the entire waveform or between
CUrsors.

NOTE. An invalid pulse definition (such as 0 samples for the high or low steps) will not let the waveform
compile.

Apply Modifications To. The modifications can be applied to the analog waveform and the markers. By
default, only the markers are selected.

Apply Modification To

D Analog
. Marker 1
- Marker 2

Range. You can apply the pattern modifications to the entire waveform (All Samples) or between the
CUISOTS.

Range

| Between Cursors

If you select Between Cursors then the cursors are automatically turned on. This also turns on the
cursors in the Home tab. Position the two cursors on the displayed waveform in order to define where
the pattern is applied.

The waveform display has the same control functions as those for the waveform in the Home tab, such
as zooming.

Properties

You can select any waveform contained in the Waveform List to view its properties.

Select a waveform and right mouse click to display the waveform operations.
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Waveforms tab

Properties

= Open Waveform

Name ‘ Len

to assign waveforr

Modify Waveform 4
: Wave 11 Modify Markers
W 6 Make a Copy
Apply Correction
Save
Save As...

Rename
Assign to

Remove

Remove All

Properties

Select Properties to display the Waveform Properties dialog screen.

m Waveform Properties E\@
Waveform name waveform10
Length 2,400 Points
Recommended sample rate | 25 G5/s
Recommended amplitude 250 mVpp
Waveform last modified 2/11/2016 8:52:21.37
File last saved 2/11/2016 8:52:21.37
Folder CA\Program Files\Tektroni\AWGT70000\Samples
File name waveform10.wimx

The Waveform Properties dialog screen provides many details about the waveform that are static (not able
to modify). The items you are able to modify include:

36
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Waveforms tab Applying Sin(x)/x correction

= Signal Format: Use the available selections to indicate the format of the waveform.
= Undefined: Not specified. This is the default selection.
= Real: Select to describe a waveform containing data other than I or Q.
= I: Select to describe a waveform containing I data.
= Q: Select to describe a waveform containing Q data.

®  Recommended sample rate: This is typically defined by the waveform when it was created. You can
change the recommend sample rate as needed.

B  Recommended amplitude: This is typically defined by the waveform when it was created. You can
change the recommend amplitude as needed.

®  Recommended offset: This is typically defined by the waveform when it was created. You can
change the recommend offset as needed.

NOTE. Recommended settings are used when the system is defined to use the waveform settings instead
of the system settings during playout.

Applying Sin(x)/x correction

Select the Sin(x)/x distortion correction to apply to the waveform. The End Frequency of the Sin(x)/x
distortion correction is initially set to /2 the recommended sample rate of the waveform.

T Apply Correction @

. Sin(x)/x distortion correction

End Frequency 6 GHz 1

Ly
I:_‘QJI

O Correction File Path 1 |E‘

: Overwrite Waveform} [ Apply } [ Cancel }

Choose to either create a new waveform or overwrite the existing waveform and select Apply.

Applying correction file

Correction files for AWG70000 series waveforms can contain two types of coefficients, RF coefficients or
1Q coefficients.
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Waveforms tab Applying correction file
B RF coefficients can be applied to Real, I, or Q files. Select a single waveform and apply the correction
file.

B [Q coefficients must be applied to two waveforms, I and Q. Select the two waveforms (high lighting
both at the same time) and apply the correction file.

A window opens to allow you to navigate to the saved coefficient file (correction file).

% Apply Correction @
'Q Sin(x)/x distortion correction

End Frequency

@ Correction File Path | C:\Program Files\Tektronbx\AWG70000\Sal | ‘E)‘ ‘{@:}‘

{Create New Waveform| Overwrite Waveform Apply ‘ ‘ Cancel ‘

Use the browse folder icon to navigate to a saved correction file.
Choose to either create a new waveform or overwrite the existing waveform.

Once a valid file path is entered, the Correction Settings icon .= ‘ {‘}‘ is enabled. Select the Setting icon to

display the Frequency Response screen which shows plot information and provides Advanced options to
apply a Gaussian filter or remove Sin(x)/x distortions.

T Frequency Response @
Magnitude Response Phase Response
1147 26.27
)
=z ™
@
3 T =
E il 5 Wyl
! 1)
g Y-M.f;'r'-\r'\" i e ‘||'| il /*"M’ ’
= 0 -6.61
4G 8G 12G 4G 8G 12G
Frequency (Hz) Frequency (Hz)

(~) Advanced Options
D Apply Gaussian Filter ?

Bandwidth

D Remove corrections for Sin(x)/x distortions from correction file

| OK “:Cancel]
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Waveforms tab Apply S-Parameters

Apply S-Parameters

S-Parameters (scattering parameters) can be applied to a waveform by selecting a waveform in the
Waveform List and selecting to modify the waveform.

NOTE. The S-Parameter selection becomes available only if an S-Parameter license is currently installed.

Selecting to apply S-Parameters displays the Apply SParameter dialog screen to select the S-Parameter file
and define its characteristics.

Below is a sample S-Parameter dialog screen with the Number of Ports set to 4. The dialog screen changes
to accommodate the Number of Ports selected.

The information provided for S-Parameters apply to both the Non-Cascading and Cascading modes.
Maode MNon-Cascading Cascading De-embed
Bandwidth Auto

Number of Ports

5-Parameter File C\Program Files\Tektronix

Signalling Scheme

Single-Ended Differentia
Selection of the port

Tx-Port

1 -
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Waveforms tab Apply S-Parameters

Item Description

Mode Select Non-Cascading or Cascading S-parameter mode.

In the Non-Cascading mode, you apply S-parameter characteristics on the signal
from only one S-parameter file.

M Non-Cascading Cascading

Bandwidth Auto -
Number of Ports 8 v

5-Parameter File

In the Cascading mode, you can cascade up to six S-parameter files in Stages and
apply the characteristics on the signal. You can select the files to apply by turning on
or turning off the corresponding Stages shown in the display. All the selected files
should be of the same type. The settings depend on the selected type of file.

Mode Non-Cascading Cascading
Bandwidth Auto -

Number of Ports 8

Stage 1
Stage 2

Stage 3

Stage 4

Stage 5
Stage 6
Paort Selection

The files supported are s1p, s2p, s4p, s6p, s8p, and s12p.

De-embed Check the box to invert the S-Parameters from the signal. This removes the effects
(Non-Cascading mode) of the component (for which the S-Parameters were created) from the signal path.

Cascading De-embed
(Cascading mode)

Bandwidth Auto - The bandwidth is defined at the point where the signal rolls off to -60 dB. If
this results in a bandwidth greater than the instrument supports, the bandwidth is set
to %2 of the waveform’s sample rate (i.e. Nyquist Frequency).

Full Bandwidth — The bandwidth is set to %2 of the waveform’s sample rate (i.e.
Nyquist Frequency).

Manual — The bandwidth can set by the user from 1 Hz to % of the maximum sample
rate of the instrument. If the set Bandwidth is greater than the Nyquist (Sample rate
of the waveform/2), then the software limits the bandwidth to % of the waveform’s
sample rate. A warning message is provided.
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Apply S-Parameters

Item

Description

Number of Ports

Choose the number of ports. The port matrixes supported are 1, 2, 4, 6, 8, and 12.
The number of ports selected determines:

* The type of S-Parameter file to apply

* The Signalling Scheme choice

* The port matrixes available

S-Parameter File

Navigate to the Touchstone file to apply to the signal. The type of Touchstone files
that you are able to open is dependent on the number of ports selected. For instance,
only .s4p files can be opened if the Number of Ports is set to 4.

The files supported are s1p, s2p, s4p, s6p, s8p, and s12p.

Signalling Scheme
(Only for 4, 8, and 12 ports)

Signle-Ended: If the data is single-ended, you must map the port numbers as used in
the file to physical locations in your link.

Differential: If the data is differential, you must select the data layout in the file.

Selection of the port

(No port selection for 1 Port
environments)

Use the diagrams to map the ports for the transmitter ports (Tx-Port) and the receiver
ports (Rx-Port).

When choosing the number of Ports, you are presented with an active diagram of
the ports. The diagram presented reflects the Number of Ports selected and the
Signalling Scheme (if appropriate for the ports selected).

Victim
Aggressor and Both
(Only for 8 and 12 ports)

Victim: The default setting with no cross-talk effects.

Aggressor: Select this to activate aggressor signal parameters, adding the effect
of cross-talk.

Port Selection

The Port Selection button is available only when in Cascading mode. Press the
Port Selection button to display an active dialog screen to map the ports for the
transmitter ports (Tx-Port) and the receiver ports (Rx-Port) for each stage.

Tx-Port Rx-Port Tx-Port Rex-Port

Victim ME =1ER 1 ~|O :IE]

= Gad.bed  Ead.pEd)
Aggressor E - j[? vl [3 'IE . j

R raea - I =COE2 I vaea - I =103

@® Single-Ended

® Single-Ended

© Differential © Differential

S-Parameter file descriptions

1-port

Files with one port of data contain only one S-parameter file (s1p) so they do not require any further input.
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2-port

Files with data for two ports contain four S-parameters as a 2x2 matrix. These are Touchstone 2-port files
(s2p). A dialog box is created to define the 2-port mapping.

4-Port

Files with data for four ports contain 16 S-parameters as a 4x4 matrix. These are Touchstone 4-port files
(s4p). They may contain single-ended or differential data. A dialog box is created to define the 4-port
mapping for either single-ended or differential data.

®  [fthe data is single-ended, you must map the port numbers as used in the file to physical locations in
your link.

You can select the port for both transmitter and receiver from the drop-down list. Each drop-down list
has ports from 1 to 2.

®  [fthe data is differential, you must select the data layout in the file.

6-port

Files with data for six ports contain 36 S-parameters as a 6x6 matrix. These are Touchstone 6-port files
(s6bp). A dialog box is created to define the 6-port mapping.

8-Port

Files with data for eight ports contain 64 S-parameters as an 8x8 matrix. These are Touchstone 8-port files
(s8p). They may contain single-ended or differential data. A dialog box is created to define the 8-port
mapping for either single-ended or differential data.

m  If the data is single-ended, you must map the port numbers as used in the file to physical locations in
your link.

You can select the port for both transmitter and receiver from the drop-down list. Each drop-down list
has ports from 1 to 4.

m  [fthe data is differential, you must select the data layout in the file.

12-Port

Files with data for 12 ports contain 144 S-parameters as an 12x12 matrix. These are Touchstone 12-port
files (s12p). They may contain single-ended or differential data. A dialog box is created to define the
12-port mapping for either single-ended or differential data.

B [fthe data is single-ended, you must map the port numbers as used in the file to physical locations in
your link.

You can select the port for both transmitter and receiver from the drop-down list. Each drop-down list
has ports from 1 to 6.

B [fthe data is differential, you must select the data layout in the file.
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Apply S-Parameters

Aggressor signals

8 and 12 port S-parameters allows you to activate aggressor signal parameters and to add the effect of
cross-talk. 12 port S-parameters allows 2 Aggressor signal parameters.

Aggressors can be added in either Non-Cascading Mode or Cascading Mode.

The Aggressor signal parameters include:

Item Description
Signal Choose the type of aggressor signal with the dropdown list:
* Clock: Indicates that the aggressor signal is a clock pattern.
* PBRS: Also choose the number of bits
* File: Indicates that the aggressor signal is another pattern file. Navigate to
the Pattern file
+ Same as victim: The signal flow of the aggressor is same as the victim.
Data Rate Specify the data rate (in bps) of the signal.

This is not available when the Aggressor signal is set to be the same as the victim.

Aggressor Amplitude

Enter the signal amplitude.
This is not available when the Aggressor signal is set to be the same as the victim.

Crosstalk Type

Choose the type of crosstalk of the aggressor signal.
* Near-End Crosstalk
* Far-End Crosstalk
* Both
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Sequence tab Sequence tab

Sequence tab

NOTE. When connected remotely to an AWG70000A series instrument, the connected instrument must
have the Sequencing option installed.

The Sequences tab contains the available sequences. Right-mouse click on a sequence to display a pop-up
menu of tools to modify, rename, save, copy, and remove sequences.

To add a sequence to the list, see Adding a sequence (see page 46).

To play a sequence track, it needs to be assigned to a channel. Refer to Assigning tracks to channels

(see page 48).

Right-mouse click on a sequence to display a pop-up menu of tools to modify, rename, save, copy, and
remove sequences.

Modify Sequence

[E} Open Sequence .
Make a Copy

Save
_ Right mouse click

Save As...

on a Sequence -< Rename

v Sequence_2

W @ Sequence 3 Remove

Remove All

W : Sequence 4

Properties

Item Description

Modify Sequence Opens the Sequence tab and loads the selected sequence into the sequence editor.

Make a Copy Creates a copy of the selected sequence and places the copy in the Sequence List. The
copy is renamed by adding a numerical suffix to the end of the original name.

Save Saves the sequence to the specified location.

Save As ... Opens a window to save the sequence with a new file name. This only changes the file

name, it does not change the sequence name that appears in the Sequence List.

Rename Changes the sequence name currently displayed in the Sequence List.
Use Save or Save As .... to save the sequence with the new name.
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Adding a sequence

Item Description

Remove Use remove to remove the selected sequence(s).

Remove All Remove All removes all sequences from the Sequence List.

Properties Displays information about the sequence. Refer to the section Sequence properties

(see page 50).

Adding a sequence

To add a sequence to the Sequences tab, select the Open Sequence button. This opens a Windows dialog
box that allows you to navigate to a saved sequence or setup file. If the sequence or setup file is a valid
file type, the sequences are added to the Sequence List and waveforms (used in the sequence) are added
to the Waveforms tab. Once a sequence is in the Sequences tab, a sequence track can be assigned to a
channel for playout. (See Assign a track to a channel.) (see page 48)

Valid sequence file types

Description

.SEQX file format

Sequence file created by Tektronix AWG70000A Series instruments or
SourceXpress.

AWGKX file format

Setup file created by Tektronix AWG70000A Series instruments or SourceXpress.
Setup files can contain multiple sequences and multiple waveforms.
NOTE. Opening a setup file from the Sequence List does not restore the

instrument settings, only the sequences contained in the setup file are restored
along with any waveforms used in the sequences.

AWG file format

Setup file created by Tektronix AWG5000 or AWG7000 Series instruments.

NOTE. The Tektronix AWG5000 or AWG7000 Series instruments had predefined
waveforms available for use.

Saved setup files that used predefined waveforms did not save the actual waveform
data with the setup, only the waveform name. Hence, importing setup files that
used predefined waveforms will not import the waveforms. To import these types of
waveforms, first copy and rename the predefined waveform, then save the setup
file before importing to the AWG70000A Series instruments.

NOTE. The Tektronix AWG5000 or AWG7000 Series instruments supported
subsequencing (using another sequence as a step in a sequence). Subsequences
are imported as another sequence and added to the Sequences list.

.SEQ file format

Sequence file created by Tektronix AWG400, AWG500, or AWG600 Series
instruments.

If selecting a setup type file containing multiple sequences, you are presented with the Available Sequences
(see page 47) dialog box that lists all sequences contained in the setup file. You can load all sequences or
select a subset of the sequences. Waveforms that are part of any sequence are added to the Waveforms tab.

46
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Available sequences

M Available Sequences (===
Select Sequence(s) to open

Name ‘Steps‘ Date ‘Sampling Ratt—:-‘

Sequence 2 10 9/9/2013 10:40:13 AM 25 GS/s
Sequence 3 4 9/9/2013 10:29:40 AM 25 GS/s

Sequence 4 15  9/9/2013 10:31:17 AM 25 GS/s

Unselected sequences that are subsequences of selected items will
also be opened.

Select all Unselect all ] [ oK ] [ Cancel

NOTE. When opening an AWG70000A Series setup file (AWGX) from the Waveforms or Sequences tabs,
only waveforms and sequences are extracted, instrument settings contained in the setup file are not
restored. Use the Open Setup in the File menu to restore the settings, waveforms, and sequences from a
AWGX setup file.

If you want any of the waveforms or sequences (extracted from a setup file) to be available outside of the
setup file, select and save each individual waveform.

Multi-sequence select

Though the Open Sequence menu in the Sequences tab, you can select multiple sequence files to load
into the sequence list at once.

To select a contiguous block of files, click the first file in the block. Then hold down the Shift key as you
click the last file in the block. This will select not only those two files, but everything in between.

To select multiple files that are not a contiguous block, click one file. Then hold down the Ctrl key while
you click each additional desired file.

c CAUTION. Loading a group of sequences will overwrite any existing sequence of the same name in the
Sequences tab without warning.

NOTE. Multiple sequence selection is not available from the Open File menu in the tool bar or from the
pull-down list in the graphical waveform area.
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Saving a sequence

Saving a sequence

Assigning tracks to channels

48

Drag an entire sequence onto a channel’s plot area.

Drag a track from a sequence onto a channel’s plot area.

To save a sequence, right mouse click and select Save or Save As. This opens a Windows dialog box that
allows you to navigate to a location to save the sequence.

A sequence can consist of up to eight different tracks. (A minimum of one track is required). To play a
sequence track, you need to assign it to a channel. This is true even for a single channel instrument.

There are several methods to assign a sequence track to a channel. (See below for further information
regarding one channel and two channel instruments.)

Right mouse click on a sequence track in the Sequences tab and use the pop-up window to assign

it to a channel.

[E Open Sequence

¥ Sequence_2

: Track 1

: Track 2 ..
: Assign to b Channel 1

: Track 3 Channel 2 k

Use the drop-down list in the channel’s plot area to assign the channel to play a sequence track.
You can choose sequence tracks from sequences already loaded into the Sequences tab or you can
browse for sequence files. When browsing, you select the sequence file, and then select the track to

assign to the channel.
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T Available Tracks EI

Select a sequence track

Name ‘ Steps| Date

)

Track 1 S
Track 2

oc | [[omm

Assigning tracks on a one channel instrument
With a one channel instrument, the following actions occur when assigning a track to play on the channel:

®  [fyou drag and drop a sequence onto the channel’s graph area, Track 1 is assigned to the channel. This
is true regardless of how many tracks the sequence may contain.

B You can drag and drop (or assign) any track from any sequence onto the channel’s graph area.

Assigning tracks on a two channel instrument

With a two channel instrument, you have the option to play multiple tracks, either from the same sequence
or different sequences. You also have the option to play a sequence track on one of the channels while
playing a single waveform on the other.

The following describes the interactions between the two channels:

B You can drag and drop the entire sequence onto one of the channel’s graph area. This automatically
assigns Track 1 of the sequence to the channel.

- If the sequence has only one track, you can drag and drop the sequence to one or both channel’s
graph area and the single track will play on both channels.

- If the sequence has multiple tracks, you can drag and drop the sequence to either channel’s graph
area. In this case, Track 1 is assigned to Channel 1 and Track 2 is assigned to Channel 2. This is
the track assignment regardless of which channel you drag the sequence to.

= Ifplaying tracks from the same sequence on both channels, the channels are coupled together.
This requires that the waveforms be of equal length for each step of the two tracks. In this case,
the Force jump to... buttons are coupled together. (Coupled Sequence is displayed on the Home
tab when tracks from the same sequence are assigned to both channels.)

B You can drag and drop (assign) a specific track from different sequences onto the channel’s graph area.
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This gives you the freedom to play any track from any sequence. Since the tracks are from different
sequences, the channels are not coupled together.

B You can play a sequence track on one channel while playing a waveform on the other channel.

Edit a sequence

You can select any sequence contained in the Sequences tab to modify it or create a new sequence based on
the existing sequence. Select any sequence in the list, right mouse click to display the sequence operations.
Selecting Modify sequence opens the sequence in the Sequences tab window for editing.

Sequence properties

You can select any sequence contained in the Sequence List to view its properties.

% Sequence Properties ]
Sequence Name MySequence
Number of steps 4

Recommended sample rate | 12 GS/s ‘
Recommended amplitude | 250 mVpp ‘

Recommended offset ov

Sequence last modified 2/11/2016 10:56:09.27

File last saved 2/11/2016 10:56:39.16
Folder C\Program Files\Tektronix\AWG70000\Samples\Sequencing
File name MySequence.seqgx

=3

The Sequence Properties dialog screen provides many details about the Sequence that are static (not able
to modify). The items you are able to modify include:

= Recommended sample rate: This is typically defined by the sequence when it was created. You can
change the recommend sample rate as needed.

B  Recommended amplitude: This is typically defined by the sequence when it was created. You can
change the recommend amplitude as needed.

= Recommended offset: This is typically defined by the sequence when it was created. You can change
the recommend offset as needed.

Recommended settings are used when the system is defined to use the sequence settings instead of the
system settings during playout.
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Waveform Plug-ins

The Waveform Plug-in tab provides access to the available plug-in applications. Plug-ins provide
enhancements to the application software and are designed for installation into SourceXpress or
AWG70000A series arbitrary waveform generators.

Plug-in applications must be installed and licensed in SourceXpress in order to compile waveforms from
SourceXpress. This is true whether you are using a virtual generator or connected to an instrument.

A plug-in that has a floating license can be moved between any installation of the plug-in. Refer to
Licensing (see page 59) for information about how to use license files to enable or move a plug-in
application.

NOTE. SourceXpresss must have the license file (for a plug-in requiring a license) installed in the
SourceXpress application in order to use the plug-in.

A plug-in installed and licensed in a connected instrument is not available for use through SourceXpress
unless SourceXpress also has a license for the plug-in.

To view and install licenses, select Licenses... from the Tools menu to display the License Management

screen.
E License Management @

Host Id: SXP-9HIAHBFE4TNAT

Installed Licenses

Name Expires |
Install License l | Return License
To manage/obtain licenses, visit
hitpe/ . tek.col rodu roduct-license
Close

The Plug-in pull-down list displays the available plug-ins. (The example here shows that the Basic
Waveform and Multitone applications are installed.) As plug-ins are added, they appear in the Plug-in
pull-down list.

Waveform Plug-in

Plug-in: ]~ Compile Eﬂ [Reset Plug—inl [Help - |

Basic Waveform
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Plug-in applications have their own installation programs available for download from the Tektronix Web
site. Plug-in applications have their own documentation and help systems and are not described in this
document.

NOTE. The Basic Waveform application is provided as a standard plug-in and requires no license.

The Basic Waveform application is an integral part of the AWG70000A series generators. Refer to the
AWG70000A series help system for information about using the Basic Waveform application.

Waveforms created (compiled) using a plug-in are placed in the Waveforms tab. Use the Waveforms tab
to save or edit waveforms created by a plug-in.
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MATLAB waveform files

Tektronix AWG70000A series instruments can read waveform files created with MATLAB (.MAT), a
third party software application. MATLAB files can contain multiple waveform data sets (including
marker data) and can support files greater than 2 GB. Waveforms created with MATLAB must meet
the requirements of an AWG70000A waveform.

The AWG70000A series supports the following levels of MATLARB files:
B  MATLAB level 5 can only support files less than 2 GB.
B MATLAB level 7.3 can support files larger than 2 GB.

This section defines the proper elements and conditions that the MATLAB file must be met to create an
AWG waveform file.

AWG MAT waveform elements
Waveform elements for an AWG MATLAB file format waveform must be contained in the same .mat file.
Each waveform will be grouped together by a trailing numerical value.

B For example - given the following elements: Waveform Name 1, Waveform Data 1,
Waveform Name 2, Waveform Data 2, Waveform M1 2, Waveform M2 2, two complete
waveforms can be formed:

= The first waveform will have the name identifier from Waveform Name 1 and the data that was
held in Waveform Data 1.

= The second waveform will have the name identifier from Waveform Name 2 and the data that
was held in Waveform Data 2. Additionally, the second waveform will have Marker 1 and
Marker 2 data.

Table 1: MATLAB required elements

Element Condition

Waveform_Name_# The MATLAB file must have the "Waveform_Name_#" specified.
The "Waveform_Name_#" must contain a string value denoting the waveform name.
Waveform_Data_# The AWG MATLARB file must have the "Waveform_Data_#" specified.

The "Waveform_Data_#" must contain an array of data values (representing waveform samples) in
one of the types: double, single, or UInt16.

Ideally, double and single should have values scaling from =1 to 1, and UInt16 should have values
ranging from 0 to 65535.
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Table 2: MATLAB optional elements

Element Condition
Waveform_M1_# The AWG MATLAB file can contain marker 1 data, having the "Waveform_M1_#" specified.

The "Waveform_M1_#" must contain a UInt8 array of marker values for the waveform's Marker
1. Only 1 and 0 are considered valid values.

The length of the marker array must match that of the AWG MATLAB file format waveform data
array length.

Waveform_M2_# The AWG MATLAB file can contain marker 2 data, having the "Waveform_M2_#" specified.

The "Waveform_M2_#" must contain a Ulnt8 array of marker values for the waveform's Marker
2. Only 1 and 0 are considered valid values.

The length of the marker array must match that of the AWG MATLAB file format waveform data
array length.

Waveform_Sam- The AWG MATLAB file can contain the sampling rate, having the "Waveform_Sampling_Rate_#"
pling_Rate_# specified.
The "Waveform_Sampling_Rate_#" must contain a "Double" value, indicating the waveform's
suggested sampling rate.
The specified sampling rate is the waveform's recommended sampling rate, but it will not directly
change any sampling rate settings of the instrument.

Waveform_Ampli- The AWG MATLAB file can contain the waveform amplitude, having the "Waveform_Amplitude_#"
tude_# specified.

The "Waveform_Amplitude_#" must contain a "Double" value, indicating the unique waveform's
suggested amplitude.

The specified amplitude is the waveform's recommended amplitude, but will not directly change
any amplitude settings of the instrument.

Waveform_Sig- The AWG MATLAB file can contain the waveform signal format having the
nal_Format_# "Waveform_Signal_Format_#" specified.

The "Waveform_Signal_Format_#" must contain a 'String' value indicating the unique waveform's
signal format.

Signal format indicates whether a Waveform is of the format type: Real, I, or Q.

MATLAB waveform file example

The following MATLAB coding example demonstrates how to create a MATLAB file that:
B creates a small, simple sinusoidal waveform with markers
B saves the waveforms into separate files

B saves the waveforms into a single file

MATLAB waveform coding example

%% Create Sinusoid
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MATLAB IQ file example

x = 2399;

t=0:1:x;

baseWfm = sin(2*pi*1/x*t); % Generate Sine Wave
baseMarkers = uint8(square(2*pi*1/x*t,50));

%% Create Waveform 1 (Double)

Waveform Name 1 ='MyDoubleWfm';

Waveform_Data_1 = baseWfm; %already a double array
Waveform M1 1 = baseMarkers; %already uint8 array
Waveform M2 1 = baseMarkers;

save('AWG_Double', '* 1','-v7.3"); % MAT 7.3 Can save > 2GB

%% Create Waveform 2 (Single)
Waveform Name 2 = 'MySingleWfm';
Waveform Data 2 = single(baseWfm);
save('AWG_Float', '* 2','-v7.3");

%% Save All Waveforms

save('All Wfms.mat', 'Waveform *', '-v7.3");

MATLAB IQ file example

The following MATLAB coding example demonstrates how to create a MATLAB file that:

creates a complex signal
creates and saves an [ waveform

creates and saves a Q waveform

MATLAB IQ file coding example

clear;clc;
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%% Create Complex Signal

nConstellationPoints=4; % Number of Constellation Points
numSymbols=1000; % Number of Symbols
samplesPerSymbol=10; % Samples per symbol

% For the Symbol Rate of 1M the Sampling Rate would be 10M
% Symbol Rate = Sampling Rate / Samples per Symbol

alpha=0.35; % RC Filter Rolloff (Alpha)
convLength=21; % Convolution Length

baseDataPattern=mod(randi(nConstellationPoints, 1, numSymbols),nConstellationPoints); % Creates
the base data

y=pskmod(baseDataPattern,nConstellationPoints, pi/4); % Creates the PSK modulation
rrcfilter = rcosdesign(alpha,convLength, samplesPerSymbol); % Create the filter coefficients

IQData = upfirdn(y, rrcfilter, samplesPerSymbol); % Filter and Interpolation

clear nConstellationPoints numSymbols samplesPerSymbol alpha convLength

clear baseDataPattern y rrcfilter

%% Retrieve 1Q Data
iData = real(IQData);
gData = imag(IQData);

%% Normalize to +1/-1

maxI = max(abs(iData));
maxQ = max(abs(qData));
maxMax = max(maxl, maxQ);
iData = iData / maxMax;

gData = qData / maxMax;

IQData = iData + li*qData; % Re-set [ and Q data
plot(IQData)
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clear max] maxQ maxMax

%% Create I Waveform

Waveform Name 1 ='Myl Waveform';
Waveform Data 1 = iData;

Waveform Sampling Rate 1 = 10e9;

Waveform_Signal Format 1 ="T

save('MAT - MATS - AWG - I Waveform', '*_1', '-v6');
save('MAT - HDFS - AWG - [ Waveform', '* 1', '-v7.3");

%% Create Q Waveform

Waveform Name 2 ='MyQ Waveform';
Waveform_Data 2 = qData;
Waveform_Sampling Rate 2 = 10e9;

Waveform_Signal Format 2 ='Q';

save('MAT - MATS - AWG - Q Waveform', '* 2', '-v6');
save('MAT - HDFS5 - AWG - Q Waveform', '* 2','-v7.3");

%% Save Files
save('MAT - MATS - AWG - Complex Waveforms.mat', '* 1','* 2' '-v6");
save('MAT - HDF5 - AWG - Complex Waveforms.mat', '* 1','* 2' '-v7.3");

%% Create Invalid Waveforms
%Too many waveforms
Waveform Name 3 = 'TooManyWfms';

Waveform_Data_3 = Waveform_Data_2;

save('MAT - MATS - AWG - Invalid Too Many Complex Waveforms', '*_1','* 2' '* 3' '-v6');
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save('MAT - HDF5 - AWG - Invalid Too Many Complex Waveforms', '* 1','* 2''* 3' '-v7.3");

%Mismatching Sample Rates
Waveform Sampling Rate 2 = 1e9; %1G & 10G

save('MAT - MATS - AWG - Invalid Complex SR Mismatch Waveforms', * 1','* 2' '-v6');
save('MAT - HDF5 - AWG - Invalid Complex SR Mismatch Waveforms', '* 1','* 2', '-v7.3");
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Licensing overview

License files are used in SourceXpress to enable optional plug-ins and features.

A Licensing scheme is used to host your license files. The product license administration is through
Tektronix Asset Management System (TekAMS). TekAMS has an easy to use web based interface that
provides:

B Inventory of all the licenses in the company account
m  Ability to check out a license
B Ability to check in a license

The Tektronix Asset Management System is available at http://www.tek.com/products/product-license .

To view and install licenses in SourceXpress, select Licenses... from the Tools menu to display the
License Management screen.

E License Management @

HostId: SXP-MCHKQ53X35KBD
Installed Licenses

Name Expires ‘

Install License Return License

To manage & obtain licenses, visit
http:/fwww.tek.col roducts/product-license

Generally, to properly install and activate a plug-in application, follow these steps.

1. Purchase a license from Tektronix. See How to purchase a license (see page 60).

2. Store the license file in a location available to the application. This can be on the instrument’s drive, a
USB flash drive, or any networked drive.

3. Obtain the plug-in installation file. Plug-in installation files are available for download from the
Tektronix web site.
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4. Install the plug-in application.

5. Install the license file. See How to install a plug-in license (see page 60).

How to purchase a license

Contact your local Tektronix Account Manager to purchase a plug-in license. After purchasing, you will
receive an email listing the licenses purchased. The email also contains the URL to the Tektronix Asset
Management System (TekAMS) that enables you to manage your licenses.

Floating Licenses provide the ability to move the license from an instrument or a personal computer to
another by checking in a license from an instrument or PC and checking it out to another.

The Tektronix Asset Management System (http://www.tek.com/products/product-license ) provides an
inventory of the license(s) in your account. If a license is a Floating license, it also enables you to check
out or check in the license.

There are three different types of licenses available for plug-ins:

License type Description

Node-Locked License ! This license is permanently assigned to a specific Hostid or product
model/serial number.

Node Locked Licenses provide your own copy of the application on
your instrument or personal computer.

Floating License This license can be moved between different Hostids or product
models.

Use the Tektronix Asset Management system to check in and check
out floating licenses.

Free Trial License This license has the same functionality as the floating license except
that it has a limited time period.

1 A Node-Locked license can be move up to two times after the initial installation to allow for operating system upgrades or other PC failures.

How to install a license

License files are used to enable optional applications.

NOTE. Applications may have been previously installed, but without a license, you cannot create
waveforms.

1. Select Licenses... from the Tools menu to display the License Management screen.

60 SourceXpress Printable Help Document


http://www.tek.com/products/product-license

Licensing How to install a license

2. Select the Install License button to display the license file selection
screen and browse to the location where you’ve stored the license
oo |

Organize » Share with + Burn New folder

= -

=

- Computer o MName Date modified Type
£, 0SDisk (C)
5 DVD RW Drive (D] [
e Removable Disk (E:)
9 mbd (\\us-bv-g03) |
S wee (VkekfsB) ())

[ D HOSTID_QHL79YTU34BCK_MTOMNENL-5501_ENTER.LIC  10/2/2015 2:26 PM  LIC File

ﬁle. 7 ]|+

3. Select the license file and select Open.

4. After the successful installation is finished, the name of the plug-in is listed along with the expiration
date and time.

Floating licenses display the expiration date for that application. The expiration date for a floating
license is defined when the license is checked out from the Tektronix Asset Management system.
After the license expires, the application is automatically disabled and the license on the TekAMS is
free to be assigned to a different host.
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How to return a license

Node locked license have no expiration date.

How to return a license

62

You can return a floating license to the Tektronix Asset Management System (TekAMS). After a floating
license is returned to the TekAMS, it becomes available to be assigned to a different host.

NOTE. Only floating licenses can be returned and reassigned to different hosts.

When assigning a license, you need to specify the host id or instrument and include the duration the feature
is to be enabled on the host. This is all done on the Tektronix Asset Management System (TekAMS) web
site. After the license expires, the feature is automatically disabled on the host and the license on the
TekAMS is free to be assigned to a different host.

1. Select Licenses... from the Tools menu. Under Installed Licenses, select the license to return and select
Return License. (A confirmation box is displayed in order to continue.)

E License Management @
HostId: SXP-9HIAHGFE4TNAT
Installed Licenses
Name | Expires |

[ Install License l [ Return License ]

To manage & obtain licenses, visit
hittp:/fwww.tek.comyproducts/product-license

After confirming to continue, a license exit file will be created. You need to provide a name for the exit
file and browse to a location to save the license exit file.

E Provide a name to save the exit license key. @

@Qv|_ » Computer » Removable Disk (E:) - |¢’| | Search Removable Disk (E:) §el [

File name: -

Save as type: [License File(*.lic) v]

* Browse Folders [ Save J ’ Cancel ]
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NOTE. The next step creates and saves the exit file. Once the exit file is created, the application will
immediately become nonfunctional (unable to compile).

2. Browse to the location where you would like to place the exit file (for example, a network drive or
a USB memory stick), and select Save to generate the exit file.

3. Login to your account on TekAMS (Tektronix Asset Management system) and upload the exit file.
Once the license is returned successfully, it can be re-assigned to a different host or instrument.
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